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FCC information for the USA 
 

This equipment has been tested and found to comply with the limits for a Class B digital device, 

pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reasonable protection 

against harmful interference in a residential installation.  This equipment generates, uses and can 

radiate radio frequency energy and, if not installed and used in accordance with the instructions, 

may cause harmful interference to radio communications.  However, there is no guarantee that 

interference will not occur in a particular installation. If this equipment does cause harmful 

interference to radio or television reception, which can be determined by turning the equipment off 

and on, the user is encouraged to try to correct the interference by one or more of the following 

measures: 

 

• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected . 

• Consult the dealer or an experienced radio/TV technician for help  . 

Important 

This equipment was tested for FCC compliance under conditions that include the use of shielded 

cables and connectors between it and the peripherals. It is important that you use shielded cables 

and connectors to reduce the possibility of causing Radio and Television interference. 

 

If the user modifies the PCS64I unit or its connection cable in any way, and these modifications are 

not approved by Velleman, the FCC may withdraw the user’s right to operate the equipment. 

 

The following booklet prepared by the Federal Communications Commission may be of help: 

“How to identify and Resolve Radio-TV Interference problems”. This booklet is available from the 

US Government Printing Office, Washington, DC20402 Stock No. 044-000-00345-4. 
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GENERAL 
The PCS64i is a digital storage oscilloscope, using an IBM compatible computer and its monitor to 

display waveforms. All standard oscilloscope functions are available in the DOS or Windows 

program supplied. Its operation is just like a normal oscilloscope with the difference that most 

operations can be done using the mouse. The markers for indicating voltage and frequency also 

provide considerable ease of use and can be operated without difficulty using the mouse. Apart 

from being used as an oscilloscope, the unit can also be used as a spectrum analyzer up to 16 MHz, 

and as a transient signal recorder, for recording voltage variations or for comparing two voltages 

over a longer period (up to more than 1 year!). 

Connection is through the computer's parallel port, the scope is completely optically isolated from 

the computer port. 

The oscilloscope and transient recorder have two completely separated channels with a sampling 

frequency up to 32 MHz in real time, oversampling of 64MHz is possible in the Windows 

software. Any waveform displayed on the screen can be stored for later use in documents or for 

comparison of waveforms. 

Technical data 

General 

• Two separate channels 

• Input impedance: 1 MOhm/30pF 

• Input bandwidth: 13MHz 

• Maximum input voltage: 100V (AC + DC) 

• Maximum readout error: 2.5% 

• Input coupling: DC, AC and GND 

• Vertical resolution: 8 bit 

• Real time sampling frequency: 32MHz (max.) 

• Oversampling: 64MHz (only in Windows) 

• Memory: 4Kb/channel 

• Supply voltage: 9 - 10VDC / 800mA 

• Charger circuit for rechargeable batteries: 90mA 

• Dimensions: 225 x 165 x 40mm 

Minimum system requirements 

• IBM compatible PC 

• Windows 95 or 3.11 or MS_DOS 

• VGA display card (min. 800x600 for Windows) 

• Mouse 

• Free printer port LPT1 

• 480Kb free conventional memory (Dos 

software) 

• Arithmetic coprocessor needed for RMS 

readout and spectrum analyzer 

Optional accessories  

• Battery pack: BP9 

• Oscilloscope probes (2x): PROBE60S (isolated) 

• Carry case: BAG21X19 

Oscilloscope 

• Timebase: 100ns to 100ms per division 

• Trigger source: CH1, CH2 or free run 

• Trigger edge: rising or falling 

• Trigger level: adjustable in steps of ½ division 

• Step interpolation: linear or smoothed 

• Markers for voltage and frequency 

• Input sensitivity: 10mV to 5V/division 

• Pre-trigger function (not in 64MHz mode) 

• True RMS readout (only AC component) 

Spectrum analyzer 

• Frequency range: 0 .. 800Hz to 16MHz 

• Linear or logarithmic timescale 

• Operating principle: FFT (Fast Fourier 

Transform) 

• FFT resolution: 2048 lines 

• FFT input channel: CH1 or CH2 

• Zoom function 

• Markers for amplitude and frequency 

Transient recorder 

• Timescale: 20ms/Div to 2000s/Div 

• Max record time: 9.4hour/screen 

• Automatic storage of data 

• Automatic recording for more than 1 year 

• Max. number of samples: 500/s 

• Min. number of samples: 1 sample/20s 

• Markers for time and amplitude 

• Zoom function 

• Record and display of screens 

• Data format: ASCII 
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INSTALLATION AND CONNECTION 

Connection 

The unit is connected to the printer port LPT1 of the computer, using a parallel cable.  

Connect the mains voltage DC adapter to the unit : 9VDC / 800mA. (pin = positive). After 

switching on the unit, the LED on the front panel should lid. 

 

MATTENTION: Only use adapter with correct voltage otherwise the unit could be damaged. 

Using a wrong power supply could blow the internal fuse. The fuse is soldered onto the PCB, 

please contact an experienced service center, to replace the fuse. The best way is to cut the leads of 

the fuse , and to solder a new (2A PICO) fuse onto the old leads. 

Rechargeable batteries (option) 

The unit can operate with a rechargeable battery pack; our type BP9. 

Open the housing by loosening the screws underneath, mount the battery pack at the appropriate 

space under the strap then plug in the connector J15 (watch the position of the connector). 

 

MATTENTION: Make sure that the battery leads are not caught between the housing when 

tightening the screws. 

  

FWhen the equipment is switched off, the charging time will be around 12 hours, the autonomy 

of the unit is around 1 hour. The LED at the back of the unit will come on while the batteries 

are charging. It is recommended to discharge the batteries before charging. 

SOFTWARE INSTALLATION 
Two types of software are supplied with the unit: 

1. Software to run the unit under MS_DOS1. 
2. Software to run the unit under MS_Windows 3.11 or Windows 951  

FCheck our web site www.velleman.be for updates. 

FIf the software is supplied on CD-ROM, then see the instructions on the CD-ROM for 

installation. 

Under MS_DOS 

Insert the diskette into the disk drive. 

Type A:setup. 

The setup program will make a directory; PCS64 on the C: hard disk, where the program is then 

copied to. 

FA DATA sub directory is also made where the subsequent graphic files and data files will be 

stored that are produced by the program. Do NOT remove this directory. 

If after leaving the program the stored pictures and/or ASCII text are not to be lost, then they have 

to be transferred from the DATA directory to another directory. If this is not done the next set of 

measurements will overwrite these files. 

Under MS_Windows 

Open the File Manager and run the "Install" program on the diskette. 

A directory, WinDSO will be made on the hard disk. A program group will be made in Windows. 

                                                                        
1
 MS_DOS and MS_Windows are trademarks of Microsoft Corporation 



  

8 

Running the program 

Under MS DOS: 

Type C:\PCS64\PCS64. The program will start in oscilloscope mode. At the top a selection can be 

made for Spectrum analyzer (FFT) or recorder (REC). 

 

Under MS Windows: 

Open the program group WinDSO 

Double click the Oscilloscope icon  for the scope or spectrum analyzer, or double click the 

Transient Recorder icon for the recorder software. 

REMARK: When starting the program for the first time, a box will appear to select your hardware. 

Choose the PCS64i . 

 
 

!  IMPORTANT INFORMATION AND OPERATION 
 

Check also the “readme” text for possible changes (only for Windows) 

 

Before making measurements and for safety reasons, it is important to know some information 

about the measured unit. 

 

Safe devices are: 

• Battery operated equipment 

• Equipment supplied via a transformer or adapter. 

 

Unsafe devices are: 

• Equipment directly connected to mains (e.g. old TV sets)  

• Equipment that contains components that are directly connected to mains (dimmers…). 

 

It is advisable, when measuring on above equipment, to use a isolation transformer. 

Always be careful when measuring directly to the mains, please remember that the ground of both 

channels is interconnected ! 

 

FIMPORTANT: Prior to measuring high voltages, set the probe to the X10 position. 
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Unit operation 
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The potentiometers control the vertical (Y) position on the display. 

The input select switches, CH1 and CH2, have 3 positions: 

AC: the input signal is capacitively coupled to the input amplifier/attenuator. Only the AC 

components are measured . 

: the input signal is broken and the input amplifier/attenuator is connected to earth. Use this 

position for selecting a reference point on the display. 

DC: the input signal is directly connected to the input amplifier/attenuator. Both AC and DC 

voltage are measured. 

 

 

 

DIGITAL STORAGE OSCILLOSCOPE "DSO" 

PURPOSE 

An oscilloscope is an indispensable instrument for viewing electrical signals. The advantage of a 

digital oscilloscope is that the measured signals can be frozen for subsequent examination or 

comparison with other signals. In digitizing the signal there is the additional advantage that it can 

also be scientifically analyzed. Thus the calculation of RMS values is no problem, although 

remember that the displayed RMS value is only for the AC component of the measured signal. By 

using the markers the signal frequency can be determined (by measuring the time of one period), 

and the voltage can also be measured between the two markers. 

When using a digital oscilloscope, it should be remembered that the signal to be measured is split 

up piece-wise, i.e. into "samples". The result of such splitting is that certain signals may escape the 

sampling frequency, especially in the case of high frequency signals. 

 

Operation 

Run the PCS64 or WinDSO program. After it has started the oscilloscope screen will be displayed . 

General: A setting can be selected by clicking on the button or desired number with the left hand 

mouse button. 
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 Dos screen 

 

 

 

 
Windows screen 
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Use 

• Connect the signal to be examined to input 1 or 2 of the oscilloscope. 

• Select the correct input channel on the screen (1, 2 or both). 

• Adjust the Y potentiometers on the unit if needed. 

• Select a suitable VOLT/DIV (voltage per division) setting so that the signal occupies the full 

screen. 

• Set the TIME/DIV (time per division) switch to a suitable setting. 

 

FSee explanation of the buttons for further operation. 

 

NOTE:  Always begin with as high as possible a setting for the timebase (0.1µs) and then reduce it 

until an appropriate display is obtained. 

 

Explanation of the buttons on the screen 

FFT 

Switches to spectrum analyzer (Fast Fourier Transform) 

 

REC (only in the DOS program) 

Switches to transient recorder 

 

VOLTS/DIV 

Indication and selection of the peak-to-peak value required to fill a division per channel. The 

selected value can also be seen at the top of the display area. 

 

CH1 - CH2 

Buttons turn the display of the trace ON or OFF. To get the cursor measurements of CH2 voltage  

values switch CH1 off. 

 

TRIGGER On/Off 

Selects whether the signal is triggered (ON) or not (OFF). 

 

TRIGGER Source 

Selects the trigger source, channel 1 or channel 2. 

 

TRIG LEVEL 

Sets the triggering voltage level, a mark on the left hand of the screen indicates the level. 

In Windows a scrollbar is used. 

 

EDGE 

Chooses the trigger edge, rising edge  or falling edge . 

 

RUN ON/OFF 

Continuous display (ON) or frozen display (OFF). 

 

SINGLE 

Updates the display once when the trigger level is reached (only in RUN Off mode). 
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X-POSITION 

To move the signal horizontally on the screen. A blue line shows the trigger reference level.  

This way the signal can be shifted, to check the signal before the trigger point. Press  to 

return to the original position. 

 

•  For Windows: use the scrollbar below the display. 

 
  

•  For Dos: Use the large or small arrows, small or large steps can be taken, the button can 

also be kept pressed in. 

 

TIME/DIV 

Time indication between two divisions. The current setting is visible on the top right of the display 

area. 

FZooming: 

A frozen picture can be easily enlarged by adjusting the TIME/DIV switch. 

 

L/S 

As a digital signal consists of a series of points, it may be necessary to connect between two points 

in order to obtain a smooth curve. This button selects whether smoothed interpolation, S (best used 

for higher frequencies), or linear interpolation, L, (for slow signals) is used. The L/S select only 

works with TIME/DIV settings of 0.5, 0.2 and 0.1 us. 

  
                                Linear interpolation        Smoothed interpolation 

 

64MHz oversampling (available only in the Windows software) 

This button activates the oversampling function. This means that the number of samples is doubled 

for the same time interval, resulting in a better signal reproduction. 

The oversampling only works for repetitive signals and in the 0.1us/div and 0.2us/div ranges. 

FTriggering must be on to get stable waveform images, the refresh of the screen will also be 

somewhat slower. 

No pre-trigger function in this mode. 

The triggering point is at the left end of the displayed waveform. 

Consider using the Smooth function (S/L button) instead of 64MHz oversampling, for signals 

lower than 5MHz. 

 

SAVE (under File menu in the Windows soft.) 

To save the current signal display (black & white) BMP format in Windows and TIFF format in 

DOS. Use Save Image in the Windows soft, and type in a name. For DOS a name is generated 

with an automatic numbering (DSOnr.TIF) each time a screen is saved. 

Use Open in the Windows soft, to load and display a saved image. Use Save DSO data to save a 

text file of the 4096 measured points. 
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A DATA table could look like this: 

TIME STEP: 

160 = 0.5ms 

 

VOLTAGE STEP: 

CH1:  32 = 1V 

CH2:  32 = 1V 

 

N CH1 CH2 

 

0 155 94 

1 155 94 

2 154 94 

3 154 94 

4 153 94 

5 153 94 

6 153 94 

7 153 94 

8 152 94 

 

↓ 

 

 

4093 208 107 

4094 207 107 

4095 207 107 

 

Table explanation: 

 

Maximum 4096 samples are stored for each screen, numbered 

from 0 to 4095. 

Next to the sample number, a value is displayed in absolute 

display value: 

000 = is the bottom of the screen (0 can also mean that the 

measurement has stopped) 

255 =  is at the top of the screen 

 

TIME STEP: Used time to store a number of samples, in this 

example, it takes 0.5ms to store 160 samples. 

The time difference between sample 0 and sample 5 is: 

5 x (0.5/160) = 0.0156 ms. 

 

VOLTAGE STEP: Volts per division channel 1 and channel 2. 

In the example, value 32 equals 1V. 

A measured value of 154 equals: 154 x (1/32) = 4.8V  

 

EXIT (for the DOS soft.) 

To exit the program, Esc can also be pressed on the keyboard . 

 

Use of the indication markers 

 

 

 

Four markers are available: two horizontal 

for measuring voltage and two vertical for 

time and frequency  

 

At the bottom of the screen, the voltage 

between the two markers is displayed dV:xx 

 

The time between the two markers is 

displayed as well as the calculated 

frequency, dt:xx and 1/dt 

FNote: The voltage markers give preference to channel 1 if both channels are being used. 
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The markers can be made to appear as follows: 

• For the DOS program: 

For voltage: 

Move the mouse to the upper or lower edge of the signal display (only if markers are invisible) 

. 

Press on the left-hand mouse button and keep it pressed in, then drag the marker into the signal 

display area. The second marker can be made to appear in a similar way. 

For time and frequency: 

Move the mouse to the left-hand or right-hand edge of the signal display. 

Press on the left-hand mouse button and keep it pressed in, then drag the marker into the signal 

display area.. The second marker can be made to appear in a similar way. 

 

• For the Windows program: 

Open the View menu 

Click “Markers (DSO)” 

Now the markers can be dragged by using the mouse, horizontal for voltage, and vertical for 

time. 

Furthermore, in the view menu, it is possible to select RMS value readout. 

The “Bright Grid” function, can be used to improve the grid visibility. 

Extra’s in the Windows software WinDso: 

Edit Menu 

Copy: Copy the current screen to the clipboard 

Paste: Bring the contents of the clipboard into the screen. The Copy and Paste functions can also 

be used to bring (color) pictures to other Windows programs. 

Options Menu 

FFT Window: See spectrum analyzer 

Hardware setup: Selection of the connected oscilloscope type (normal PCS64i), with the Demo 

selection, the program can be tested (Demo also works in Win NT) 

Math Menu 

The result of mathematical operation of channel 1 and 2 is displayed. 

One of the following functions can be selected: 

Ch1 + Ch2: Sum of both channels 

Ch1 - Ch2: Substraction between both channels 

XY Plot: Ch1 data is displayed on Y axis, Ch2 data is displayed on X axis  

Invert Ch2: The second channel is inverted 

 

FA button is provided to toggle between Math mode and Normal mode. 
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How to avoid interference with the sampling frequency  

It is possible for the displayed signal not to be at the correct frequency due to interference of the 

incoming signal with the sampling frequency. Therefore, with unknown signals set the timebase to 

the highest possible value (0.1µs). The sampling frequency must be at least twice that of the signal 

being measured, see table: 

 

TIME/DIV 

setting 

Displayed sampling frequency in 

RUN mode 

 

Real sampling frequency 

(Sampling rate) 

 

0,1 us 32 Mhz 32 Mhz 

0,2 us 32 Mhz 32 Mhz 

0,5 us 32 Mhz 32 Mhz 

1 us 32 Mhz 32 Mhz 

2 us 16 Mhz 32 Mhz 

5 us 6,4 Mhz 32 Mhz 

10 us 3,2 Mhz 16 Mhz 

20 us 1,6 Mhz 8 Mhz 

50 us  640 Khz 3,2 Mhz 

0,1 ms 320 Khz 1,6 Mhz 

0,2 ms 160 Khz 800 Khz 

0,5 ms 64 Khz 320 Khz 

1 ms 32 Khz 160 Khz 

2 ms 16 Khz 80 Khz 

5 ms 6,4 Khz 32 Khz 

10 ms 3,2 Khz 16 Khz 

20 ms 1,6 Khz 8 Khz 

50 ms 640 Hz 3,2 Khz 

100 ms 320 Hz 1,6 Khz 

 

 

 

 

SPECTRUM ANALYZER "FFT" 

Purpose 

Only one fundamental frequency of a signal can be properly measured using an oscilloscope, the 

levels of other frequencies cannot be easily examined and compared simultaneously. The spectrum 

analyzer is the solution to this problem. 

Because the incoming signal is digitized, it is possible for the signal to be scientifically converted 

into its frequency spectrum (using FFT - Fast Fourier Transforms). 

With the spectrum analyzer program supplied, it is possible to view the signal in terms of its 

frequency spectrum. Thus, the harmonics in a distorted, imperfect sine wave (e.g., square wave) 

can be examined. 

Furthermore the spectrum analyzer can also be used for measuring filter circuits, etc. 

 

OPERATION 

Start the PCS32  / DSO program if it is not already running. 

After starting, the oscilloscope screen will be displayed and then press on FFT. 
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General 

A setting can be selected by clicking on the desired number or button with the left-hand mouse 

button.  

 

 
Dos screen 

 

 
Windows screen 
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Use 

• Connect the signal to be examined to oscilloscope input 1 or 2. 

• Set the input select switch to AC position. 

• Select the correct input channel (1 or 2) on the screen. 

• For the DOS software: 

Set the spectrum analyzer in WAVE position and ensure that the signal is 2 to 4 divisions 

large by adjusting VOLT/DIV. 

• For the Windows software: 

Check the signal in oscilloscope setting and ensure that the signal is 2 to 4 divisions large by 

adjusting VOLT/DIV. 

 

Adjust the Y position potentiometers on the unit if necessary. 

Now switch over to FFT. 

Set the FREQ RANGE (frequency range) to a suitable setting. 

FSee "explanation of the buttons" for further operations. 

 

NOTE:  Always begin with as high a frequency setting as possible and then reduce it until a 

suitable display is obtained. 

 

Explanation of the buttons on the screen 

DSO 

Switches over to oscilloscope (Digital Storage Oscilloscope). 

 

REC (only in the DOS soft) 

Switches over to transient recorder. 

 

VOLTS/DIV 

Indication of the peak-to-peak value needed to fill a division per channel (in Oscilloscope or 

WAVE display). 

 

ON 

Selects the FFT input channel. 

 

TRIG ON/OFF 

Choose between free run or  "trigger" 

 

TRIGGER Source (only in the Windows soft.) 

Selects the trigger source, channel 1 or channel 2 

In the DOS software, this is done automatically 

 

TRIGGER EDGE 

Select the trigger edge, rising edge  or falling edge  

 

TRIGGER LEVEL 

Set the level that it triggers at, a mark on the left-hand edge of the screen indicates the level. 

In the Windows program, a scrollbar is used. 

 

RUN ON/OFF 

Continually adjust screen (RUN) or freeze screen (OFF). 
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SINGLE 

Adjust the screen once when the trigger level has been reached (only in RUN OFF position) . 

X-POSITION 

To move the signal horizontally on the screen. 

Press  in order to return to the original position. 

• For DOS: 

By using the large or small arrows it can be moved in large or small steps, the buttons can also 

be kept pressed in. 

• For Windows: 

use the scrollbar below the display 

 
 

DISPLAY FFT / WAVE (only in the DOS software) 

Select spectrum analyzer display or normal signal display. 

 

FREQ. RANGE 

Frequency range of the display, it is necessary to slide the screen using X-POSITION in order to 

see the full range. 

 

Log.  /  Lin. 

To display the frequency on a linear or logarithmic scale. 

 

ZOOM 

In order to expand the screen  X1, X2, X4 or X8 

A frozen picture can be easily be expanded by selecting a ZOOM factor. 

 

SAVE (in the File menu for Windows) 

In order to save the current waveform in (black and white) BMP format for Windows and TIFF 

format for DOS 

Use Save Image in the Windows soft, and type in a name. For DOS a name is generated with an 

automatic numbering (FFTnr.TIF) each time a screen is saved. 

Use Open in the Windows soft, to load and display a saved image. Use Save FFT data to save a 

text file of the 160 measured points. 

 

A DATA table could look like this: 

N f/[kHz]  V/[dBV] 

0 0.0000  -39.8 

1 0.3125  -50.5 

2 0.6250  -47.3 

3 0.9375  -4.4 

4 1.2500  -49.2 

5 1.5625  -56.1 

↓ 

156 48.7500  -72.1 

157 49.0625  -72.4 

158 49.3750  -67.7 

159 49.6875  -73.7 

 

Table explanation: 

 

160 samples are taken for each screen, 

numbered from 0 to 159 

 

The frequency and level are indicated.  
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EXIT (for the DOS software) 

To exit the program, Esc can also be pressed. 

 

Use of the indication markers 

 

 

Three markers are available: two 

horizontal for measuring the level in 

decibels and a vertical one for measuring 

the frequency. 

 

 

The markers can be made to appear as follows: 

• In the DOS software: 

For level: 

Move the mouse to the upper or lower edge of the signal display. (only when the markers are 

invisible) 

Press on the left-hand mouse button and keep it pressed in, then drag the marker into the signal 

display area. 

The second marker can be made to appear in a similar way. 

The level between the 2 markers is displayed in decibels (dB). 

For frequency: 

Move the mouse to the left-hand or right-hand edge of the signal display. (only when the 

markers are invisible). 

Press on the left-hand mouse button and keep it pressed in, then drag the marker into the signal 

display area. 

The frequency is displayed. 

FNote: 

When zooming in, it may be possible for the vertical markers to disappear off the left-hand or 

right-hand edge of the screen. In such a case, the marker can be brought back from the edge it 

disappeared into in a similar way as described above. 

 

•  For the Windows software: 

Open the View menu 

For the spectrum analyser, there are two possibilities 

Click “Markers (DSO)” 

Now the markers can be dragged by using the mouse, horizontal for voltage, and vertical for 

time. 

Furthermore, in the view menu, it is possible to select RMS value readout. 

The “Bright Grid” function, can be used to improve the grid visability. 
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FNOTE: Regularly check that the signal amplitude has not become too high, by switching over 

the display using the WAVE or Oscilloscope function. 

 

Extra’s in the Windows software WinDso:  

Edit Menu 

Copy: Copy the current screen to the clipboard 

Paste: Bring the contents of the clipboard into the screen. The Copy and Paste functions can also 

be used to bring (colour) pictures to other Windows programs. 

Options Menu 

FFT Window:  

It is common practice to taper the original signal before calculating the FFT (Fast Fourier  

Transformation). This reduces any discontinuities at the edges of the signal. This is done by  

multiplying the signal with a suitable window function. The undesirable spectral leakage can be 

reduced using a tapered window. Many different windows have been designed for this purpose.  

 

The choice of a suitable one depends on the nature of the signal or data, and on the type of  

information to be extracted from its spectrum. In general, a good FFT window has a narrow main  

spectral lobe to prevent local spreading of the spectrum, and low sidelobe levels to reduce 'distant'  

spectral leakage. In some cases it may be best to leave the data alone -- in effect, to use a  

rectangular window. 

Other selections: Barlett, Hamming, Hanning and Blackman. 

 

Hardware setup: Selection of the connected oscilloscope type (normal PCS64i), with the Demo 

selection, the program can be tested (Demo also works in Win NT) 

 

 

TRANSIENT SIGNAL RECORDER "REC" 

PURPOSE 

If short one time changes are to be recorded, then it is best to use a transient recorder. This device 

can best be compared to a tape recorder, but is used for recording electrical signals. The signal 

recorder is nothing other than an oscilloscope with a very slow timebase. The advantage of a digital 

recorder is that the signals can be stored on disk, so that they can be used for analysis at a later 

time. By making the timescale very slow, and by selecting the automatic save function, signals can 

be checked for up to 1 year, and on the two channels simultaneously. By using the markers it can 

also be accurately determined when a change has occurred and how large the change is. 

 

OPERATION 

Start the WinDSO Transient recoder program if it is not already running. 

After starting the PCS64 DOS program, you will come to the oscilloscope screen, then press REC . 

General: A setting can be chosen by clicking on the button or desired number with the left-hand 

mouse button. 
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DOS screen 

 

 

 
Windows screen 
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Use 

• Set the input select switch to  (GND) position. 

• Select the correct input channel on the screen (1, 2 or both). 

• Set the TIME/DIV (time per division) setting to 0.02 sec . 

• Press on RUN and if necessary adjust the Y potentiometers on the unit until a line is visible at 

the desired place. 

• Connect the signal to be examined to the oscilloscope input 1, 2 or both. 

• Select a suitable setting by adjusting the VOLT/DIV (voltage per division) setting. 

• Set TIME/DIV to a suitable setting for your application. 

• Set the input selection switch to DC position . 

 

FSee explanation of the buttons for further operations. 

Explanation of the buttons on the screen 

FFT (only in the DOS software) 

Switches to spectrum analyzer (Fast Fourier Transform). 

 

DSO (only in the DOS software) 

Switches to oscilloscope. 

 

VOLTS/DIV 

Indicates the peak-to-peak value required to fill a division per channel. 

 

CH1 - CH2  

Switches the given channel in or out (ON/OFF in the DOS software). 

 

SINGLE 

When pressed a screen recording will take place. By pressing on the left-hand mouse button the 

recording is interrupted. In the Windows program the SINGLE button must be pressed again, to 

stop. 

 

RUN 

Start a recording, when the end of the display is reached a new recording will be started. By 

pressing on the left-hand mouse button the recording will be interrupted. In the Windows program 

the RUN button must be pressed again, to stop. 

NOTE: In RUN mode the lowest displayed speed is 0.2s/div, despite the fact that a higher speed 

may have been selected. After completion of the recording, the correct value is shown again. 

 

SAVE (under File menu in Windows) 

IMAGE 

In order to save the current waveform in (black and white) BMP format for Windows and TIFF 

format for DOS 

Use Save Image in the Windows soft, and type in a name. For DOS a name is generated with an 

automatic numbering (RECnr.TIF) each time a screen is saved. 

Use Open in the Windows soft, to load and display a saved image. 

 

DATA 

To save a text table of the screen data. 

In Windows after selecting Save Data, a name can be entered (see further for explanation of this 

table). In DOS, the name is automatically numbered RECnr.ASC. 
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A Data file could look like this: 
 

START: 1/04/98 15:58:29 

 

TIME STEP: 100 = 1s 

 

VOLTAGE STEP: CH1:  32 = 1V 

    CH2:  32 = 1V 

 

N CH1 CH2 

 

1 35 160 

2 36 161 

3 36 161 

4 37 161 

5 37 161 

↓ 

211 80 222 

212 79 223 

213 79 224 

↓ 

1700 90 228 

 

 

STOP:   1/04/98 16:00:18 

Table explanation: 

 

1700 measurement values are taken per display, numbered 

from 1 to 1700. In addition to this, the measured values can 

be read off from channel 1 and channel 2. The measured 

value is presented in an absolute screen value. 

 

START: Date and time when starting the recording 

STOP: Date and time when the recording was stopped 

000 = at the bottom of the screen (or when recording was 

stopped before the end of the screen was reached). 

255 = at the top of the screen. 

TIME STEP: The time it takes to measure a number of 

samples. In the example it takes 1 sec to take 100 samples. 

At measurement point 212: 

Point in time: 212 x 1/100 = 2.12s (after start time) 

 

VOLTAGE STEP: Volt/division CH1 and CH2 

Here value 32 is equal to 1V 

 

So value 80 at sample 211 is actually 2.5V, 

(80x1/32) = 2.5V 

 

 

AUTO 

After starting, each screen is automatically stored. And a new recording is started. 

• For DOS: 

Each screen is automatically stored and numbered, (RECnr.ASC). 

A  maximum of 999 recordings can be stored, after this the recording returns to 000. 

Each screen is also stored binary so the images can later be recalled through the LOAD, PREV 

and NEXT buttons. Each screen takes about 28K hard disk space (including binary file). 

NOTE: 

Re-examination of stored pictures is possible as long as the program has not been exited. The 

pictures are erased when EXIT is pressed. 

For experienced computer users: 

If you want to avoid this then the line "del \data\*.bin > nul" can be removed from the 

PCS64.BAT file  (or place a REM before the line). 

 

•  For Windows (In File menu): 

Through AutoSave Data, a name can be entered for the file. 

This file will automatically be updated (grow) with the recordings. At the end of the file a stop 

time will be indicated. The number of recordings is only limited by the free disk space, each 

screen takes about 20K space. 

 

EXIT (for the DOS software) 

To exit the program, Esc can also be pressed. 
 

TIME/DIV 

Time between two divisions, from 0.02s to 2000s. 
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FZooming and moving the display 

A frozen picture can easily be enlarged by adjusting the TIME/DIV setting . 

 

X-POSITION 

To move the signal horizontally on the screen (useful after zooming, see above).  

 

• For DOS: 

By using the large or small arrows, the signal can be moved in small or large steps, the button 

can also be kept pressed in. Press  to return to the original position. 

• For Windows: 

Use the scrollbar below the display. 

 
 

Use of the indication markers 

 
Four markers are available: two horizontal ones for measuring voltage and two vertical for 

measuring time. The markers can be made to appear as follows: 

FNote: 

the voltage markers give preference to channel 1 if both channels are being used. 

 

The markers can be made to appear as follows: 

• For the DOS program: 

For voltage: 

Move the mouse to the upper or lower edge of the signal display (only if markers are invisible). 

Press on the left-hand mouse button and keep it pressed in, then drag the marker into the signal 

display area. The second marker can be made to appear in a similar way. 

For time: 

Move the mouse to the left-hand or right-hand edge of the signal display. 

Press on the left-hand mouse button and keep it pressed in, then drag the marker into the signal 

display area.. The second marker can be made to appear in a similar way. 
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•  For the Windows program: 

Open the View menu 

Two possibilities are available for the markers 

Markers dV&t: Markers are available for voltage and one for time. 

Markers dV&dt: Markers are available for voltage and two for time, to measure also time 

difference. 

The markers can be dragged by using the mouse, horizontal for voltage, and vertical for time. 

Furthermore, in the view menu, the “Bright Grid” function, can be used to improve the grid 

visibility. 

Extra’s in the Windows software: 

Edit Menu 

Copy: Copy the current screen to the clipboard 

Paste: Bring the contents of the clipboard into the screen. The Copy and Paste functions can also 

be used to bring (colour) pictures to other Windows programs. 

Options Menu 

Hardware setup: Selection of the connected oscilloscope type (normal PCS64i), with the Demo 

selection, the program can be tested (Demo also works in Win NT) 
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TROUBLESHOOTING 
The program doesn't start. (DOS software) 

 
• Not enough conventional memory (min. 460k) 

• Start the program directly under DOS 

• Are all files in the correct directory 

 
No mouse pointer appears. 

 

• No mouse driver installed 

 
Storage of data and displays does not work (DOS 

software). 
• The DATA directory is not in the PCS64 directory 

 

 

RMS and Spectrum analyser display doesn't work. 

 

• No arithmetic coprocessor in the computer (386 or 

lower processor). 

  

No signal on the oscilloscope display 

 

• No communication with the computer (check 

cable) 

Check the printer port setting in the BIOS SETUP 

of the computer (best at normal or SPP if this 

choice is possible) 

• Program is not in RUN ON 

• The channel concerned is OFF 

• TIME/DIV switch is in the wrong setting, try 1ms 

• TRIG is ON, set TRIG OFF 

• The unit input select switch is at GND. 

• Y position potentiometer is wrongly adjusted. 

• Input amplitude too large, adjust VOLT/DIV 

setting. 

FIf the above tips have no effect, then test on a 

different computer or replace the printer port card. 

 
Interference in the displayed signal. 

 

• The computer cable is too long (max. 1.5m) or of 

poor quality. Use the cable supplied. 

 

The voltage readout does not correspond to the 

actual value. 

 

• The probe is in the X10 position 

• Note, the RMS readout measures only the AC 

voltage. 

• The oscilloscope must be calibrated. 

 

No communication with the computer. • Use printer port LPT1. 

• Cable too long or bad connection. 

• Program is not in RUN ON 

 

With no input signal, the line jumps vertically on 

the screen after changing the VOLT/DIV setting. 

• Offset adjustment not correct. 

 

 

WARRANTY 
This product is guaranteed against defects in components and construction from the moment it is purchased and for 

a period of ONE YEAR starting from the date of sale. 

This guarantee is only valid if the unit is submitted together with the original purchase invoice. VELLEMAN-KIT 

Ltd. limits its responsibility to the reparation of defects or, as VELLEMAN-KIT Ltd. deems necessary, to the 

replacement or reparation of defective components. Costs and risks connected to the transport, removal or 

placement of the product, or any other costs directly or indirectly connected to the repair, will not be reimbursed by 

VELLEMAN-KIT Ltd. VELLEMAN-KIT Ltd. will not be held responsible for any damages caused by the 

malfunctioning of a unit. 
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DIAGRAMS &SERVICE INFO
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POWER SUPPLY 

 

 

 

 

 

INPUT CIRCUIT 

 

All values are for reference only



  

 29 

 

 

 

 
 

DIGITAL  CIRCUIT 

 

All values are for reference only 
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Offset CH1

Testpoint J9

Offset CH2

Testpoint J10

CH1 calibration CH2 calibration

CH1 transient 1V/div

CH1 transient 0.1V/div

CH2 transient 1V/div

CH2 transient 0.1V/div

 
 

 

 

 

 

 

SERVICE INFO 
 

Adjustment Signal setting Adjust 

   

CH1 transient 0.1V/DIV Set at 0.1V/DIV & test signal J10 CV2 

CH1 transient 1V/DIV Set at 1V/DIV & test signal J9 CV1 

CH1 offset Switch between 1V & 5V/DIV Adjust RV1 for stable signal 

CH1 callibration / RV7 for correct readout 

   

CH2 transient 0.1V/DIV Set at 0.1V/DIV & test signal J10 CV4 

CH2 transient 1V/DIV Set at 1V/DIV & test signal J9 CV3 

CH2 offset Switch between 1V & 5V/DIV Adjust RV4 for stable signal 

CH2 callibration / RV9 for correct readout 
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